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Overview

A Formula uses numeric and variable values (e.g., select lists, numeric or date fields, or
workflow states) to generate Incident Severity, Estimated Damage, or Incident Likelihood.
Formulas are added to an Object Type through a Relationship or Reference.

A formula appears on a form as a number, label (e.g., Low, Medium, High), numbers and labels,
gauge, or as a formula card.

Related Information/Setup

For more information on formulas, see the following articles:

¢ Formulas Overview

¢ Variables, Operators & Functions
¢ Time Functions

e Null Values in Formulas

e Formula Examples

e Formulas on Forms

Navigation

1. From the Home screen, click the System icon.

Home ~ My Tasks

System Icon

2. From the Admin Overview screen, click the Object Types tile on the Data Models

section.
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3. From the Object Types screen, enter an Object Type Name in the Search field to
narrow down the Object Types list.

4. Click the Object Type's Name you want to edit.

848

Data Model ~ Object Types

Admin:Object Types

Activity
@ Activity
@ Activity Type
F Finding

Results or evidence from a specific audit activity

L Log

Single entry of related activity to an Investigation or Case, used for evidentiary purposes. including times and costs.

i Task

Actionable record for key data objects (Incident, Case, Activity) with user assignment, date tracking and email notifications.

M VIEW OBIJECT TYPE UNIVERSE

Click the Object Type's Name

5. From the Edit Object Type screen, scroll down and select the Formulas tab.
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Data Model v Object Types
Admin: Edit Object Type

Activity Type

Workflow

Concatenations

£+ CONFIGURE NAME CONCATENATION

## CONFIGURE DESCRIPTION CONCATENATION

Overview Fields (5) | Formulas (10) l Relationships (1) References (1) Roles (0)

Related Forms
Activity Type - CC - Create
Activity Type - CC - Edit
Activity Type - IRM - Library
Related Data Definitions

Activity Type

Summary information about the Object Type: related forms, object type groups, activities / applications, Reports, report definitions..

Priority: none
Priority: none

Priority: none

_ v PonE

Formulas Tab

6. From the Formulas tab, click on the + Add Formula button.
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Data Model ~ Object Types

Admin: Edit Object Type

Activity &

Workflow

£ CONFIGURE WORKFLOW

Concatenations

£+ CONFIGURE NAME CONCATENATION
x

#+ CONFIGURE DESCRIPTION CONCATENATION

Overview Fields (18) Formulas (9) Relationships (16) References (1) Roles (1)

+ ADD FORMULA

All of the formulas that have been built Activity.

ACTCOUNT o
ACT None

Activity DoW o
mod|({(timediff{SUPPLIED_DT.0,"hours")+TimeZoneNDEPTH+1)/24)+4) 7) Label

Activity ToD o
mod|{{timediff{SUPPLIED_DT.0,"hours")+TimeZoneNDEPTH+1)-5),24) Label

Count o
COUNT None

Earliest Response Time o
timeDiff(ARRIVEDDAT, ASSIGNEDDA "minutes”) None

Linked Incident Count o
IncExists Label

On Site Time o
timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"minutes") None

Priority o
PRIORITY Label

Time Spent o
HOURS==INULL?HOURS:timeDiff[CLEAREDDAT, ASSIGNEDDA, "hours") None

- ¥ pone

Add Formula Button

Adding a Formula to an Object Type

1. From the Create New Formula screen, enter a formula name in the Name field (e.g.,

Estimated Vehicle Damage).
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Create New Formula

CANCEL

Name Field

2. Click the Create button.
3. The Formulas tab will appear, listing the newly created formula.

4. Click the new formula to open the Edit Formula pop-up.

® (Qseomn & 0a
Data Model ~ Object Types Object Type Groups Fields Assessments Data Definition
3 Formula (CDV-RCN)CDV will render with 2 None .
EDIT FORMULA X
Amount Under Insured
3 Formula CDV-RCN will render with a None -
- - DETAILS
Highest Single Calculated RCN Value
3 Formula MAXRCN will render with a None
. N * Name
Highest Single Customer Declared Value
1 Formuia MAXCDV will render with a None Number of Properties
Lowest Single Calculated RCN Value Description
& Formula MINRCN will render with a None
Number of Locations
3 Formula loc will render with a None
Number of Projects
3 Formula pro will render with a None =
VARIABLES
Number of Valuations
Total Client Declared Value - Buildings
1 Formuia SUMCDYV will render with a None
FORMULA v v

Edit Formula Pop-up

5. (Optional) Enter a description documenting the Formulas internal use in the Description
field.

6. From the Variables section, Click the + Add Variable button.
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Data Model v Object Types Object Type Groups Fields Assessments Data Definition
T} Formula (CDV-RCNNCDV will render witn & None .
EDIT FORMULA x
Amount Under Insured
3 Formula CDV-RCN will render with a None -
- - DETAILS
Highest Single Calculated RCN Value
§ Formula MAXRCN will render with a None
~ R * Name
Highest Single Customer Declared Value
3 Formula MAXCDV will render with a None Number of Properties
Lowest Single Calculated RCN Value Description
3 Formula MINRCN will render with a None
Number of Locations
1 Formuia lec will render with a None
Number of Projects
} Formula pro will render with @ None =
Number of Properties
¥ Formula will render with 2 None VARIABLES
Number of Valuations
F Formua et vilrener with aNone
Total Client Declared Value - Buildings
1 Formula SUMCDV will render with a None
FORMULA -

+ Add Variable Button

7. From the Variables section, select a Variable Type from the drop-down list. A Variable is

a value in which the formula calculations are performed.

¢ Field: After selecting the Field variable, the following field will appear:
o Available Components: Select a field or formula from the Available

Components drop-down field adding it directly to the Object Type.

Note:

@ Fields can be added to formulas after they are added to an Object Type or if they are
associated through a relationship or reference. Only numeric fields, date fields, and

select lists with numeric values are accepted. For more information, see the Fields article.

@ (Q search.. 000 e N
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
Overview | Fields (3) Formulas (14) Relationships (1) [RSRLLILASISETITCY X

VARIABLES

All of the formulas that have been buitt Account. *Variable Type * Available Components

% Insured Gap Field
¥ Formula -(CDV-RCN)/CDV will render with a Label and Result
#Name
% Over Insured
i Formula -VAL will render with a None
% Under Insured -
Description

3 Formula (CDV-RCNNCDV will render with s None

Amount Under Insured
3 Formula CDV-RCN will render with 2 None
Treat empty values as Null

Estimated Vehicle Damage
§ Formula will render with a None

CANCEL
Highest Single Calculated RCN Value

3 Formula MAXRCN wil render with = None

Variable Type = Field

¢ Relationship: After selecting the Relationship variable, the following fields will

appear:


http://help.resolver.com/help/fields
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o Relationship: Select the Object Type Relationship from the drop-down list.
Relationships connect two or more objects. The user must add a Relationship to
an Object Type to appear on the Relationship drop-down list. See the Add
Relationships to an Object Type article for further information on adding a
Relationship to an Object Type.

o Available Components: Select a field or formula from the Available
Components drop-down field adding it directly to the Object Type.

o Sub Type: Select a Sub Type from the drop-down list. Subtypes specify how
the data from multiple objects are compiled, calculated, and displayed. For
more information on Subtypes, see the Sub Type Table in the Variables,
Operations, & Functions article.

= Array: Creates a set of values from the variable.

= Sum: Calculates a total from the variable's set of values and returns a
single number. Select list variables cannot use Sum Sub Types.

= Count: The number of times a variable has been added to an object.

= Average: Calculates an average number from the variable's set of
values. Select list variables cannot use Average Sub Types.

= Every: Checks if the variable contains a value on the objects in the
relationship/reference.

= Min: Calculates the lowest humber from the variable's set of values.
Select list variables cannot use Min Sub Types.

= Max: Calculates the highest number from the variable's set of values.

Select list variables cannot use Max Sub Types.

Data Model v Object Types Object Type Groups Fields Assessments Data Definition

® (Q search 000 e N

Overview Fields (3) Formulas (14) Relationships (1) [EALESHUTR x

VARIABLES

All of the formulas that have been built Account. *Variable Type * Relationship

% Insured Gap Relationship
§ Formula -(CDV-RCN)/CDV will render with a Label and Result
Available C
% Over Insured

§ Formula -VAL will render with a None

% Under Insured Sub Type

3 Formulz (CDV-RCNNCDV wil render with s None

Amount Under Insured
§ Formulz CDV-RCN will render with a None * Name

Estimated Vehicle Damage

Formula will render with 2 None

Description
Highest Single Calculated RCN Value

3 Formula MAXRCN will render with 2 None

Highest Single Customer Declared Value
} Formula MAXCDV will render with a None

Treat empty values as Null

Lowest Single Calculated RCN Value CANCEL
§ Formula MINRCN will render with a None

Number of Locations

Variable Type = Relationship


https://help.resolver.com/help/add-relationships
https://help.resolver.com/help/operators-functions-functions

Resolver.

A KROLL BUSIMESS

* Reference: After selecting the Reference variable, the following fields will appear:

o Reference: Select the Object Type Reference from the drop-down list.

References indicate that an object is connected to another object through a

relationship. References are automatically created when a relationship is

created. For further information on adding a Relationship to an Object Type,

see the Add References to an Object Type article.

o Available Components: Select a field or formula from the Available

Components drop-down field adding it directly to the Object Type.

o Sub Type: Select a Sub Type from the drop-down list. Subtypes specify how

the data from multiple objects are compiled, calculated, and displayed.

All of the formulas that have been built Activity.

ACTCOUNT

ACT None

Activity DowW

mod({{(timediff(SUPPLIED_DT.0."hours")+ TimeZone

Activity ToD

mod({{timediff(SUPPLIED_DT0,"hours") + TimeZonel

Count

COUNT Nane

Earliest Response Time

timeDiff(ARRIVEDDAT, ASSIGNEDDA."minutes”)

Estimated Vehicle Damage

None

Linked Incident Count

IncExists Label

On Site Time

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"mi

Data Model v Object Types

EDIT FORMULA X

VARIABLES

Variable Type Reference

Reference

Name

Description

Treat empty values as Null

CANCEL

Variable Type = Reference

¢ Property: After selecting the Property variable, the following field will appear:

o Property: Select a Property type from the drop-down list:

= |Is Submitter Confidential: This property type creates a formula that

compares the number of confidential submissions against the number of

not confidential submissions for customers that use the

Confidential Reporting Portal.


https://help.resolver.com/help/references
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@ (Q search ooo @ @ Q
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
O Fields (3) Formulas (14) RISt EDIT FORMULA x
VARIABLES
All of the formulas that have been buitt Account. * Variable Type * Property
% Insured Gap Property
¥ Formula -(CDV-RCN)/CDV will render with a Label and Result
#Name
% Over Insured
§ Formula -VAL will render with a None
% Under Insured .
~ Description
3 Formula (CDV-RCNNCDV will render with 2 None
Amount Under Insured
3 Formula CDV-RCN will render with 2 None
Treat empty values as Null

Estimated Vehicle Damage
% Formula will render with a None CANCEL

Highest Single Calculated RCN Value

3 Formula MAXRCN wil render with = None

Variable Type = Property

8. The system will automatically populate the Name field with the field or formula's unique ID
by default.

9. (Optional) Enter a Variable name in the Name field.

Warning:
A Using a function name (Sub Type Name) in the name field will cause an error.

@ Q Search. ooo @ @ 2

Data Model ~ Object Types Object Type Groups Fields Assessments Data Definition
T} Formuia (COV-RCNCDV will render with 2 None -
EDIT FORMULA X
Amount Under Insured
§ Formula CDV-RCN will render with 3 None -
Highest Single Calculated RCN Value VARIABLES

3 Formula MAXRCN wil render with = None

Highest Single Customer Declared Value #Variable Type * Available Components
1 Formuia MAXCDV will render with a None
Field Number of Locations

Lowest Single Calculated RCN Value

3 Farmula MINRCN will render with s None * Name

Number of Locations NUMBEROFLOCATIONS

5 Formula loc will render with a None

Description

Number of Projects

3 Formula pro will render with a None

Number of Properties
3 Formula will render with s None Treat empty values as Null

Number of Valuations CANCEL
§ Formula Val will render with a None.

Total Client Declared Value - Buildings
1 Formuia SUMCDYV will render with a None

Variable Name

10. (Optional) Enter a Variable description in the Description field.

11. (Optional) Select the Treat empty values as Null checkbox to exclude blank objects
from a formula calculation. For more information, see the Null Values in Formulas article.

12. Click the Create button to add the variable. The system will perform the Syntax Validation
function, and an error message will appear under the Formula field, reminding the user to

add the variable name to the Formula field.
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@ (Qsearch. oo B0
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
§ Formula -VAL will render with a None EDIT FORM X
% Under Insured -
§ Formula (COV-RCNNCDV will render with 3 None Description
Amount Under Insured
i Formula CDV-RCN will res vith 3 None
Highest Single Calculated RCN Value LB A T eaL
§ Formula MAXRCN will render with a None
CANCEL
Highest Single Customer Declared Value
3 Formula MAXCDV wil r with a None
. NUMBEROFLOCATIONS x
Lowest Single Calculated RCN Value Formuls Number of Locations  Treat empty v null False
§ Formulz MINRCN will render with a None
Number of Locations
& Formuia lec will render with a None FORMULA
Number of Projects
3 Formula pro will render with a None S ERT RO P
- <
Number of Properties _ .
5 Formula will render with a None e v
“ »
Number of Valuations 3
N Error: Please remove numberoflocations or add them to the formula.
§ Formula Val will render with a None
Total Client Declared Value - Buildings e
1 Formuia SUMCDYV will render with a None
Total Replacement Cost Amount - Buildings .

Variable Error Message

13. Click the Insert Variable button and select a Variable from the dropdown menu. The

selected Variable will be added to the Formula field.

@ (Q search.. ooo @ @ Q
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
rvover mauey — =
% Formula -VAL will render with a None EDIT FORM X
% Under Insured -
§ Formulz (CDV-RCN)CDV will render wit Description
Amount Under Insured
i Formula CDV-RCN will res 2 None
Highest Single Calculated RCN Value LB A T eaL
§ Formula MAXRCN will render with a None
CANCEL
Highest Single Customer Declared Value
1 Formula MAXCDV will render with a None
. NUMBEROFLOCATIONS x
Lowest Single Calculated RCN Value Formula: Number of Locations  Treat empty values as nulk false
3 Formula MINRCN will render with a None
Number of Locations
1 Formuia lec will render with a None FORMULA
Number of Projects
¥ Formula pro will render with a None T — P
- <
Number of Properties NUMBEROFLOCATIONS .
& Formuia will render with a None v
T »
Number of Valuations 5
N Error: Please remove numberoflocations or add them to the formula.
3 Formula Val will render with a None:
Total Client Declared Value - Buildings SAVEECRESIS
§ Formula SUMCDV will render with a None
Total Replacement Cost Amount - Buildings .

Insert Variable Button

14. Click the Save Formula button. The Formula field will indicate if the Formula syntax is

correct. If the Formula syntax is correct the Formula will be saved.
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3 Formula VAL will render with 2 None

% Under Insured

1 Formula (COV-RCN)CDV wil rendes

Amount Under Insured
§ Formula CDV-RCN will rendh

with 2 None

Highest Single Calculated RCN Value

3 Formuiz MAXRCN wil render with 3 None

Highest Single Customer Declared Value
1 Formula MAXCDV will render with a None

Lowest Single Calculated RCN Value

3 Formulz MINRCN will render with a None

Number of Locations

¥ Formula loc will rander with 2 None

Number of Projects

3 Formula pro wil render with s None

Number of Properties
3 Formula NUMBEROFLOCATIONS will render with a None

Number of Valuations
§ Formula Val will render with a None

Total Client Declared Value - Buildings

3 Formula SUMCDV will render with a Nene

Total Replacement Cost Amount - Buildings

@ ( Q search..

Data Model v Object Types Object Type Groups

o00 S @ Q

Assessments Data Definition

EDIT FORM

Description

Treat empty values as Null

CANCEL
NUMBEROFLOCATIONS x
Formula: Number of Locations Treat empty values as null: false
FORMULA
INSERT VARIABLE &
NUMBERQFLOCATIONSE .
“ »
Formula syntax is correct. Formula saved.
SAVE FORMULA V¥ RECALCULATE AND REFORMAT

Formula Syntax
Note:
Click the Expand icon on the Formula field to open the Expandable screen mode.
@ (Q Search 000 89
Data Model v Object Types Object Type Groups Assessments Data Definition
$ Formule ~VAL will ender with a None EDIT FORMULA
% Under Insured x
3 Formula (CDV-RCN)/CDV will render with 2 None Description
Amount Under Insured
1 Formula CDV-RCN will render with a None
Highest Single Calculated RCN Value [Usatenptivakuesiaz Buil
1 Formula MAXRCN will render with a None
CANCEL
Highest Single Customer Declared Value
§ Formula MAXCDV wil render with a None
) NUMBEROFLOCATIONS x
Lowest Single Calculated RCN Value Formula: Number of Locations  Treat emp It false
T Formuiz MINRCN will render with a None
Number of Locations
I FORMULA
Number of Projects
¥ Formula pro will render with a None INSERT VARIABLE v m
Number of Properties N
3 Formula NUMBEROFLOCATIONS will render with a None. NUMBERGFLOCATIONSE -
< >
Number of Valuations
s s e s Formula syntax is correct. Formula saved.
Total Client Declared Value - Buildings SUERERILL VX RECALCULATE AND REFORMAT
1 Formula SUMCDYV will render with a None
Total Replacement Cost Amount - Buildings .

Expand Icon

15. Repeat steps 11 - 16 to add additional variables.

16. Click the x icon next to the variable to delete the variable.
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Data Model v Object Types

EDIT FORMULA X

All of the formulas that have been built Activity.
ACTCOUNT
ACT None
Activity DowW
mod(({(timediff(SUPPLIED_DT.0."hours")+ TimeZone
Activity ToD
mod({{timediff(SUPPLIED_DT.0."hours")+ TimeZonel
Count
COUNT None

Earliest Response Time

timeDiff(ARRIVEDDAT, ASSIGNEDDA "minutes")

Estimated Vehicle Damage

REPORTEDDA None

Linked Incident Count

IncExists Label

VARIABLES

Variable Type

Select one...

Name

Description

Treat empty values as Null

REPORTEDDA

CANCEL

8O

X Icon - Delete a Variable

17. From the Formula section, enter a Formula using the variable name(s) you entered in the

Name field under the Variables section. Include operators and functions in the

Formula field (e.g., INCIDENTSE==3). For more information on Operators, see the

Operators Table in the Variables, Operators, & Functions article.

18. A system notification will appear under the Formula field, indicating that Your formula is

not saved.

19. The Recalculate and Reformat button will be greyed out, preventing invalid formulas

from being sent to the processing queue and causing a potential slowdown.

@ ( Q search

Data Model ~ Object Types
" Internal Audit Project - Control Workilow

Control Self-Assessment Workflow (Risk & Compl
Control Status

IT Compliance Assessment Control Workflow
Internal Controls Assessment - Control Workflow
Compliance Testing Workflow (Prototype)

IT Risk Assessment Control Workflow

Concatenations
£ CONFIGURE NAME CONCATENATION

## CONFIGURE DESCRIPTION CONCATENATION

Overview Fields (46) Formulas (11) Relatiol

Object Type Groups Fields Assessments

EDIT FORMULA X

-

FORMULA

INSERT VARIABLE ~

SUM(COUNT
4

SAVE FORMULA

Your formula is not saved

DISPLAY

Format Range as

None > None
|

£ REFORMAT

System Notification - Your Formula is Not Saved

20. Click on the Save Formula button. The system will perform a Syntax Validation on the


https://help.resolver.com/help/operators-functions-functions
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formula if the formula is:

Warning:
A The Autosave function was removed from the Edit Formula pop-up. Changes to the
Formula field require a user to click the Save Formula button.

Changes not manually saved will be discarded, and the system will revert to the
previously saved state.

¢ Valid: A system notification will appear under the Formula field; Formula syntax is

correct. Formula saved. The Recalculate and Reformat button will be active.

@ (Q search 000 S e o °

Data Model v Object Types Object Type Groups Fields Assessments Data Definition

Internal Audit Project - Contro Workilow :
EDIT FORMULA X
Control Self-Assessment Workflow (Risk & Compl

-

Control Status FORMULA

IT Compliance Assessment Control Workflow

INSERT VARIABLE o
Internal Controls Assessment - Control Workflow “

SUM(COUNT)|

Compliance Testing Workflow (Prototype)
4 3

IT Risk Assessment Control Workflow Formula syntax is correct. Formula saved.

SAVE FORMULA VX RECALCULATE AND REFORMAT

Concatenations

# CONFIGURE NAME CONCATENATION s
## CONFIGURE DESCRIPTION CONCATENATION

Format Range as
— None ™ None ~
QOverview Fields (46) Formulas (11) Relatiol

£ REFORMAT

System Notification - Valid Formula

¢ Invalid: A system notification will appear under the Formula field; Error Syntax
error in part (char 1). The formula is not saved. The error will indicate the
character (char) location of the error in the formula and that the formula is invalid and
not saved. The Recalculate and Reformat button will be greyed out, preventing
invalid formulas from being sent to the processing queue and causing a potential

slowdown.
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@ Q, Search_ o000 @ @ g -
Data Model ~ Object Types Object Type Groups Fields Assessments Data Definition
T Internal Audit Project - Control Workilow ;
EDIT FORMULA X
Control Self-Assessment Waorkflow (Risk & Compl
Control Status FORMULA

IT Compliance Assessment Control Workflow

INSERT VARIABLE ‘
Internal Controls Assessment - Control Workflow
sumM(counT| :
Compliance Testing Workflow (Prototype) q D
IT Risk Assessment Control Workflow Error: Parenthesis ) expected (char 10).

Your formula is not saved

A SAVE FORMULA

Concatenations
## CONFIGURE NAME CONCATENATION

DISPLAY
## CONFIGURE DESCRIPTION CONCATENATION

Format Range as

Overview Fields (46) Formulas (11) Relatiol None None
2 REFORMAT
-

System Notification - Invalid Formula

21. (Optional) Click the Recalculate and Reformat button to recalculate all the formulas in

your organization.

22. In the Display section, select a format from the Format drop-down list:

¢ None: Uses no display formats.

8o

Data Model ~ Object Types

EDIT FORMULA x

VARIABLES i

All of the formulas that have been built Activity.

il
+ ADD VARIABLE

ACT None

- REPORTEDDA x
Activity DowW
mod(({(timediff(SUPPLIED_DT.0,"hours")+TimeZone
Activity ToD
mod({{timediff{(SUPPLIED_DT.0."hours") +TimeZonel FORMULA
Count REPORTEDDA

COUNT None
Formula syntax is correct. Formula saved.

Earliest Response Time

timeDiff(ARRIVEDDAT, ASSIGNEDDA,“minutes”) SAVEEDRMNA VR RECALCULATE AND REFORMAT
Estimate Vehicle Damage
REPORTEDDA None
DISPLAY
Linked Incident Count
IncExists Label Format Range as
On Site Time Mone Mone ~

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"mi

' REFORMAT

Priority
PRIORITY Label
I . i A

Format = None

¢ Numeric: Allows the user to choose how the numbers will be displayed using the
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options on the table.
o Num: Displays numbers in numeric format.
o %: Displays numbers using percentage format.
o $: Displays numbers using dollar format.
o 0.00: Displays numbers using decimal format.

o Layout: Previews the number format selected.

@ (Q searen & °
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
EDIT FORMULA X
Overview Fields (46) Formulas (11) Relatiol
FORMULA -
INSERT VARIABLE ~ s
All of the formulas that have been built Control.
# of Related Citations SUM(COUNT) o
i Formula COUNT w fer wi J C
Formula syntax is correct. Formula saved.

% of Samples Failed

3 Formula (FAILED/TESTED) will render with a Label and Result

SAVE FORMULA VX RECALCUILATE AND REFORMAT
% of Samples Tested
§ Formula (TESTED/TOTAL) will render with a Label and Resutt
Control Self-Assessment
N DISPLAY
§ Formula CONTROLSELF wil render with a Label
Design Effectiveness R Layout Range a5
§ Formula DESIGNEFF will render with  Label -
o Num % S| 0.00]
Numer > G = None ™
DNU Num| %] -§[-0.00)
Formula will render with a None
2 REFORMAT
Net Loss
§ Formula NETLOSS will render with 2 None
v
N} b £ 1

Format = Numeric

e Range as:
o None: The formula will display the numeric results only.
o Label: The formula will display the range labels only (e.g., Low, Medium, High)
in the color selected for that range.
o Label and Result: The formula will display the numeric results and labels (e.qg.,
Low - 1000) in the color selected for that range.
o Result: The formula will display the numeric results only in the color selected

for that range.

23. If a user selects Label, Label and Results, or Results from the Range as drop-down list,

the system will automatically add three default formula labels Low, Medium, and High.
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Data Model ~ Object Types
EDIT FORMU
All of the formulas that have been built Activity. REFORTEDDA
ACTCOUNT Formula syntax is correct. Formula saved.
ACT None
SAVE FORMULA '\[; RECALCULATE AND REFORMAT
Activity Dow
modi({{{timediff(SUPPLIED_DT,0,"hours")+ TimeZone
Activity ToD DISPLAY
mod({{timediff(SUPPLIED_DT.0,"hours")+TimeZonel
Format Layout Range as
Count ) [Num| %] §[ 0.00
COUNT None plamEdics ° -Num| -%| -$/-0.00 Labelane
Earliest Response Time o REFORMAT

timeDiff(ARRIVEDDAT, ASSIGNEDDA "minutes") v

Estimate Vehicle Damage @ v P |
REPORTEDDA Label and Result - 33

Linked Incident Count Medium ‘ i}
IncExists Label 33 66

On Site Time @ ron @
1imeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"mi 68; 100

Priority
PRIORITY Label
X il i i

Formula Labels

24. Click the Edit icon next to the Formula Label you want to edit.

Data Model ~ Object Types
EDIT FORMU
All of the formulas that have been built Activity. RERORTEDD
ACTCOUNT Formula syntax is correct. Formula saved.
ACT None
SAVE FORMULA VX RECALCULATE AND REFORMAT
Activity Dow
mod{{{{timediff(SUPPLIED_DT,0,"hours")+ TimeZone
Activity ToD DISPLAY
mod({(timediff(SUPPLIED_DT.0,"hours")+TimeZonel
Format Layout Range as
Count ) [Num] %[  $[ 000
COUNT None i plamenc ° -Num| -%| -$/-0.00 Lahelant
Earliest Response Time 2 REFORMAT

timeDiff(ARRIVEDDAT. ASSIGNEDDA "minutes”) v/

Estimate Vehicle Damage . Low D i

REPORTEDDA Label and Result 7.33
Linked Incident Count Medium o
IncExists Label 33 56
On Site Time @ ron i}
66 100

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"m|

Priority

PRIORITY Label

& o e

Edit Icon

25. The Formula Label fields will appear, allowing the user to edit the field values:
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e Color: Click the Color drop-down to reveal the color picker and select a new color for
the label. You can also type a hex color into this field to select a color.

e Label: Enter a new name for the label in the Label field.

¢ Max Value: Enter a maximum value in the Max Value field, creating a numeric value

range for the Formula Label.

8 0Ea

Data Model ~ Object Types
EDIT FORMULA X
All of the farmulas that have been built Activity. Fermula syntax is correct. Formula saved.
ACTCOUNT 7
SAVE FORMULA * RECALCULATE AND REFORMAT
ACT Nene
Activity Dow
mod({{{timediff(SUPPLIED_DT,0."hours")+ TimeZone DISPLAY
Activity ToD
mod({{timediff(SUPPLIED_DT 0, "hours")+TimeZonel Format Layout Range as
) Num| % $| 0.00]
Count Numeric 0 Num| %| § 000 Label ant
COUNT Mone

£ REFORMAT

Earliest Response Time

timeDiff(ARRIVEDDAT, ASSIGNEDDA."minutes™) i
Color Label Max Value

Estimate Vehicle Damage . 2003591 Lo 33
REPORTEDDA Label and Result

Linked Incident Count Medium o
IncExists Label e 56

On Site Time @ o a

66 100

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"mj

L ADD LABEL
Pricrty

PRIORITY Label

= o & i)

Formula Label Fields

26. Click the Save icon to save your changes.
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Data Model ~ Object Types.
EDIT FORM
All of the formulas that have been built Activity. Formula syntax is correct. Formula saved.
ACTCOUNT s
SAVE FORMULA % RECALCULATE AND REFORMAT
ACT None
Activity Dow
mod({{{timedif(SUPPLIED_DT.0,"hours"} +TimeZone DISPLAY
Activity ToD
mod{{[timedit{(SUPPLIED_DT.0,"hours")+ TimeZonel Format Layout Range as
Num| % $| 0.00]
Count Numeri¢” o] Nam| -%| -s|-0.00 Label an
COUNT None

Z REFORMAT

Earliest Response Time

timeDiff(ARRIVEDDAT, ASSIGNEDDA "minutes") m
Color Label Max Value

Estimate Vehicle Damage . #00a591 e 33
REPORTEDDA Label and Result

Linked Incident Count Madiim L}
IncExists Label 33 66

On Site Time . High o

66 100

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"m|

Priority
PRIORITY Label
X il i bt

Save Icon

27. Click the Delete icon to delete a Formula Label.

Data Model ~ Object Types
EDIT FORMU
All of the formulas that have been built Activity. Formula syntax is correct. Formula saved.
ACTCOUNT bR
SAVE FORMULA % RECALCULATE AND REFORMAT
ACT None
Activity Dow
mod({{{timedif(SUPPLIED_DT,0,"hours"} +TimeZone DISPLAY
Activity ToD
mod({{timediff(SUPPLIED_DT,0,"hours") +TimeZonel Format Layout Range as
R Num| % $| 0.00]
Count Numerie 0 Nam| -%| -5|-0.00 Label an
COUNT None

Z REFORMAT
Earliest Response Time

timeDiff(ARRIVEDDAT. ASSIGNEDDA "minutes”)

Color Label Max Value
Estimate Vehicle Damage . #00a591 L 33
REPORTEDDA Label and Result
Linked Incident Count Madiim L}
IncExists Label 33 66
On Site Time . High o
1timeDIff(MAXCLEAREDDATE, MINARRIVEDDAT,"mi 66 100
Priority
PRIORITY Label
= c 4 =

Delete Icon

28. Click Add Label button to add a new label.
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Data Model ~ Object Types.
EDIT FORMULA X
All of the formulas that have been built Activity. Formula syntax is correct. Formula saved.
ACTCOUNT s
SAVE FORMULA % RECALCULATE AND REFORMAT
ACT None
Activity Dow
mod({{ (timediff(SUPPLIED_DT,0, "hours") + TimeZone DISPLAY
Activity ToD
mod{{[timedit{(SUPPLIED_DT.0,"hours")+ TimeZonel Format Layout Range as
Num| % $| 0.00]
Count Numeri¢” o] Nam| -%| -s|-0.00 Label an
COUNT None
© REFORMAT
Earliest Response Time
timeDiff{ARRIVEDDAT, ASSIGNEDDA,"minutes”) o
Color Label Max Value
Estimate Vehicle Damage . #00a591 e 33
REPORTEDDA Label and Result
Linked Incident Count Medium L
IncExists Label 2K £
On Site Time . High o
1imeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"mi 58 400
P ADD LABEL
Priority
PRIORITY Label
X il i el

Add Label Button

29. If changes are made to the Formula Label on the Display section, you must click the

Reformat button before the changes are displayed.

8o

Data Model ~ Object Types
EDIT FORMULA x
All of the formulas that have been built Activity. Formula syntax is correct. Formula saved.
ACTCOUNT T
SAVE FORMULA % RECALCULATE AND REFORMAT
ACT Nene
Activity DowW
mod({{{{timediff(SUPPLIED_DT.0."hours")+ TimeZone DISPLAY
Activity ToD
mod({{timediff{SUPPLIED_DT.0,"hours") + TimeZonel Format Layout Range as
Num| % $| 0.00
Count Numerie 0 Num| -%|  -§/-0.00 Label ant
COUNT Mone

i REFORMAT

Earliest Response Time

1imeDifflARRIVEDDAT, ASSIGNEDDA, "minutes”) m
Color Label Max Value
Estimate Vehicle Damage . 2003591 Lo 33
REPORTEDDA Label and Result
Linked Incident Count Medium f L]
IncExists Label 33 66
On Site Time @ ro @
1imeDiff(MAXCLEAREDDATE, MINARRIVEDDAT, mi 68, 100
- - ADD LABEL
proriy
PRIORITY Label
xI. c i o
Reformat Button

30. Click the x in the Edit Formula pop-up header to close the pop-up.
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Data Model v

Object Types. e Gro ldl Assessments at

EDIT FORMULA

All of the formulas that have been built Activity. Formula syntax is correct. Formula saved.

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"m|

ACTCOUNT B
SAVE FORMULA * RECALCULATE AND REFORMAT

ACT re 1 None
Activity Dow

mod({{ (timediff(SUPPLIED_DT,0, "hours") + TimeZone DISPLAY
Activity ToD

mod{{[timedit{(SUPPLIED_DT.0,"hours")+ TimeZonel Format Layout Range as

' Num| %| $|0.00|

Count Numeri¢” o] Nam| %] S 000| Label an

COUNT None

< REFORMAT

Earliest Response Time

timeDiff(ARRIVEDDAT, ASSIGNEDDA "minutes") v » m

Color Label Max Value .

Estimate Vehicle Damage . #00a591 e 33

REPORTEDDA Label and Result s
Linked Incident Count Medium L

IncExists Label e33;u 9. 66
On Site Time . High L

above 66: u 1002

Priority
PRIORITY Label
X il i bt

x Closes the Edit Formula Pop-up




